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A few quick notes before we begin ...
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A few quick notes before we begin ...

 Can you hear us okay”? (What is your goal for today’s session??)
* [0 Improve presentation clarity, limit memory- and bandwidth-
hogging applications (e.g. Dropbox, backups, etc.)
* Have issues”
 Check your settings
* Let us know in Questions box

- Try reloading the webinar
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A few quick notes before we begin ...

 Can you hear us okay”? (What is your goal for today’s session??)
* [0 Improve presentation clarity, limit memory- and bandwidth-
hogging applications (e.g. Dropbox, backups, etc.)
* Have issues”
 Check your settings
* Let us know in Questions box
e [ry reloading the webinar

- Have no fear: a replay will be available for on-demand viewing
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Question 1 (Atif)

Hello, | would like the homepage of my website to be a landing/about
page with an opt-in form. In the primary navigation is a "blog" tab,
which takes you to the blog. This is where | would like to have a primary
navigation bar too. Is this possible? Usually, you see the latest posts
(sometimes out of hundreds of posts). It would be good for my readers
to see the categories and even a sidebar with popular/latest posts.
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Step 1: Make Blog Home Page Your About Page
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Step 1: Make Blog Home Page Your About Page

& Edit # Manage

Design

Dashboara

| Appeara”“_ .

Menus Right Now In Forums v

Content Areas

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode
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Step 1: Make Blog Home Page Your About Page

X

You are customizing o
Primility

Favicon >
Colors >
Header Image >
Backstretch Image >
Background Image >
Menus >
Content Areas >
ome & Posts isplay _
Site Layout >
Breadcrumbs >
Comments >
Content Archives >
Entry Options )
Footer Options >
Scripts )
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Step 1. Make Blog Home Page Your About Page

x - :

You are customizing © ¢ Customizing

Primility Home & Posts Display
Favicon )
Colore . Your theme supports a static front page.
Header Image > Front page displays

Your latest posts

Backstretch Image >
Background Image > * Astatic page _

Menus >

Front page
Content Areas > About —
Home & Posts Display > Posts page
Site Layout > — Select —
Breadcrumbs > Max Posts Per Page
Comments > 10
Content Archives > Maximum number of posts to display on the
chtry Options . posts and archives pages.
Footer Options >
Scripts >
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X

You are customizing
Primility
Favicon
Colors
Header Image
Backstretch Image
Background Image
Menus
Content Areas
Home & Posts Display
Site Layout
Breadcrumbs
Comments
Content Archives
Entry Options
Footer Options

Scripts

s

v v v v v v vV v vV A4 v v v v v

Step 1. Make Blog Home Page Your About Page

x Note: If you make this
Customizing | change and do not see it
Home & Posts Display reflected on your live

o theme supports @ statc fromt page. site, remove all existing

cront page displays widgets from Content

Your latest posts Areas (even the defaUItS)-
® A static page _

Front page

Abour _

Posts page

— Select —

Max Posts Per Page

10

Maximum number of posts to display on the
posts and archives pages.
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Step 2: Add Opt-In Form to About Page
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Step 2: Add Opt-In Form to About Page

Content

Posts

Pages

Landing Pages
Portfolio

Podcast Episodes
Media

Redirect Links
Forums

LMS

Book Library

Post Categories
Post Tags

Podcast Network
Podcast Keywords
Portfolio Type
Editorial Calendar
Book Authors
Book Series

Book Tags

| Forms
Quizzes

RSS Feeds
Import
Export
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Step 2: Add Opt-In Form to About Page

& Edit

Content

FOrms

- Posts
Pages
Landing Pages
BTae All [
Portfolio
Podcast Episodes
Media , .
Bulk Actions Apply 20 Forms Per Page Go 1-2o0f2Forms
Redirect Links
Forums
LMS

. Form Title Shortcode Date Updated
Book Library

Contact [display_form id=1] May 15, 2014
Post Categories

Post Tags

Podcast Network
Podcast Keywords Opt-In Form [display_form id=2]

Portfolio Type Edit Delete Duplicate Preview Form View
Editorial Calendar Submissions

Book Authors
Book Series

Form Title Shortcode Date Updated
Book Tags

| Forms
Quizzes
RSS Feeds
Import
Export
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Step 2: Add Opt-In Form to About Page

T ARETEITT T R T e R T W

Pages

All (13) | Published (12) | Draft(1) | Trash (1) | Sort by Order Search Pages
Bulk Actions Apply All dates Filter 13 items

Title Author . Date ID

About - Front Page Jerod Morris — 2014/01/24 15

Edit Quick Edit Trash View Duplicate Purge cache Published

Affiliate Area Jerod Morris — 2014/09/11 340
Published

Archives Jerod Morris — 2014/04/09 80
Published

Blog Jerod Morris  — 2014/01/24 19
Published

Checkout Jerod Morris — 2014/01/22 7
Piuihliched
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Step 2: Add Opt-In Form to About Page

About Publish 4

Permalink: http://jerod-morris.preview111.i net/ View Page 3 Preview Changes

2 Edit with Visual Editor

87 Add Media

Visual Text
¥ Status: Published Edit
B I » = = ¢ — £ £ = 2 R EE * Nhbh € a0 © o=
@ Visibility: Public Edit
A Compelling Headline to Introduce Your Website’s Unique Appeal Revisions: 2 Browse

Welcome to [Name of Your Website or Business| — the answer to the question your prospects are looking for. & published on: Jan 24, 2014 @

20:22 Edit
[A photo of your founder or employees is recommended to personalize this page]

® SEO: N/A
Subscribe now to get all of our best information delivered directory to your inbox:

[display_form id=2] Move to Trash

A smart About Page is an important part of keeping the attention of vour audience. It's one of the first things Update

visitors look at when they find your website, and it can convert them into regular readers.
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About

Permalink: http://jerod-morris.preview111.rmkr.net/ View Page

8y Add Media
Visual Text

WA -

B I e ¢ -

= = N A € o © o

]!
I
il
D
5
I

B

A Compelling Headline to Introduce Your Website’s Unique Appeal

Welcome to [Name of Your Website or Business| — the answer to the question your prospects are looking for.
[A photo of your founder or employees is recommended to personalize this page]

Subscribe now to get all of our best information delivered directory to your inbox:

[display_form id=2]

A smart About Page is an important part of keeping the attention of vour audience. It's one of the first things
visitors look at when they find your website, and it can convert them into regular readers.

Step 2: Add Opt-In Form to About Page

Publish &

J Preview Changes

2 Edit with Visual Editor

¥ Status: Published Edit
@ Visibility: Public Edit
Revisions: 2 Browse

1] Published on: Jan 24, 2014 @
20:22 Edit

® SEO: N/A

Move to Trash

Default

Secondary Navigation -

Secondary Navigation

Genesis Default

Featured Image -

Set featured image

Append A Form -

-- None

v Contact \
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Step 3: Edit Primary Navigation Bar
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Step 3: Edit Primary Navigation Bar

Design

Themes

Appearance
| Menus —
Content Area

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode
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Step 3: Edit Primary Navigation Bar

Menus

Edit Menus Manage Locations

Design

Primary Menu (Header Menu) Select or create a new menu.

Themes

-
Appearance Primary Menu

Most Recent  View All Search

Menu Structure
Affiliate Area

| Menus Thank you Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.
le | i
Content Areas Example Icon Links |
Archives Home Custom Link v

Free Member Content Library
Join Our Free Content Library

Blog
Membership
Responsive Slider Blog
Library Page v
. . Contact
Dynamic Sidebars .
#15 (no title)
Custom CSS B Contact Page v
. Select All Add to Menu
Maintenance Mode
Posts - Menu Settings
Custom Links . Automatically add new top-level pages to this menu
v'| Header Menu
Categories -

After Header Menu

Footer Menu (Currently set to: Widget Menu)
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Step 4. Edit Secondary Navigation Bar
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Step 4: Edit Secondary Navigation Bar

Menus

Edit Menus Manage Locations

Secondary Menu Select or create a new menu.

P v
ages Secondary Menu m

Posts v

Custom Links v Menu Structure

c . Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.
ategories

Home CustomlLink
Most Used  View All Search
Uncategorized #15 (no title) Page v
Basics
Blog Page v
Select All Add to Menu
Library Page v
Contact Page v

Menu Settings

Automatically add new top-level pages to this menu

N

Header Menu (Currently set to: Primary Menu)
After Header Menu

Footer Menu (Currently set to: Widget Menu]
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Step 4: Edit Secondary Navigation Bar

Menus

Edit Menus Manage Locations

Select a menu to edit:

Secondary Menu Select or create a new menu.

Pages ’ Secondary Menu m

Posts -
Custom Links v Menu Structure
. Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.
Categories
Home CustomLink
Most Used ViewAll Search
v| Uncategorized #15 (no title) Page v
v Basics
Blog Page v
Add to Menu
Library Page v
Contact Page v

Uncategorized Category v

Basics Category v

Menu Settings

Automaticallv add new too-level pages to this menu fé R A I N M A K E R P I. AT F 0 R M



Step 4: Edit Secondary Navigation Bar

Menus

Edit Menus

Select a menu to edit:

Pages
Posts

Custom Links

Most Used View All

v'| Uncategorized
v Basics

Select All

+ Manage in Appearance

Manage Locations

Secondary Menu

Search

Add to Menu

v

Select or create a new menu.

Secondary Menu

Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.

Home

URL

Navigation Label

Home

Move Down one

emove | Cancel

#15 (no title)

Blog

Custom Link

Page

Page

A
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Step 4: Edit Secondary Navigation Bar

Menus

Edit Menus Manage Locations

Select a menu to edit: Secondary Menu Select or create a new menu.
Pages v
Secondary Menu
Posts -
Custom Links v Menu Structure
' Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.
Categories
Uncategorized Category v
MostUsed ViewAll Search
v| Uncategorized Basics Category v
v Basics
Select All Add to Menu Menu Settings

Automatically add new top-level pages to this menu

D AR

Header Menu (Currently set to: Primary Menu)
After Header Menu

Footer Menu (Currently set to: Widget Menu)

Delete Menu
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Step 5: Create a Dynamic Sidebar
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Step 5: Create a Dynamic Sidebar

Design

Themes

Appearance

Menus

Content Areas

Responsive Slider
| Dynamic Sidebars
Custom CSS

_

Maintenance Mode
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Design

Themes

Appearance

Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode

Step 5: Create a Dynamic Sidebar

Add New Sidebar !

Name
Blog Sidebar

A recognizable name for your new sidebar content area

ID
blog

The unique ID is used to register the sidebar content area

Description

Sidebar for blog page with secondary navigation
menu.

£

Add New Sidebar _
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Step 5: Create a Dynamic Sidebar

& Edit # Manage
Design

Themes

Appearance

Menus
| Content Areas _

Responsive Slider

Dynamic Sidebars
Custom €SS

Maintenance Mode

77 RAINMAKER PLATFORM



Step 5: Create a Dynamic Sidebar

Content Areas

Design

Themes

Appearance

Menus

| Content Areas

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode

Available Widgets

To activate a widget drag it to a content area or click on it. To deactivate a widget

and delete its settings, drag it back.

Archives

A monthly archive of your site’s
Posts.

Categories

A list or dropdown of categories.

Featured Book

Displays a single book with several
customizable display options.

Featured Posts

Displays featured posts with
thumbnails

Forms Widget

Forms Widget

Calendar

A calendar of your site’s Posts.

Custom Menu

Add a custom menu to your
sidebar.

Featured Page

Displays featured page with
thumbnails

Featured Tabs

Displays featured posts in Tabs

Forum Login Widget

A simple login form with optional
links to sign-up and lost password

pages.

Primary Sidebar

Before Header

Front Page Image

Front Page Widgets

Front Page Pricing Table

Image Page Widgets v
Footer 1 -
Footer 2 -
Footer 3 -
After Entry -
Blog A
lommm=
Title:

Select Menu:| Secondary Menu

Delete | Close m
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Step 5: Create a Dynamic Sidebar

Content Areas

Design

Themes

Appearance

Menus

| Content Areas

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode

Available Widgets

To activate a widget drag it to a content area or click on it. To deactivate a widget

and delete its settings, drag it back.

Archives

A monthly archive of your site’s
Posts.

Categories

A list or dropdown of categories.

Featured Book

Displays a single book with several
customizable display options.

Featured Posts
Displays featured posts with

thumbnails

Forms Widget

Calendar

A calendar of your site’s Posts.

Custom Menu

Add a custom menu to your
sidebar.

Featured Page

Displays featured page with
thumbnails

Featured Tabs

Displays featured posts in Tabs

Forum Login Widget

Primary Sidebar - Image Page Widgets v
This is the primary sidebar if you are using a two or Footer 1 M
three column site layout option.

Footer 2 v

Before Header v

Footer 3 v
Front Page Image v
After Entry v

Front Page Widgets v
8 8 Blog -

Front Page Pricing Table v

o

Pricing Table
Simple Social Icons: Social Icons v
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Step 6: Add Dynamic Sidebar to Blog Page
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Step 6: Add Dynamic Sidebar to About Page (Homepage)

Pages

All (12) | Published (12) | Draft(7) | Trash (1) | Sort by Order
Bulk Actions Apply All dates Filter
Title

(no title) - Front Page

Affiliate Area

Archives

Blog
Edit Quick Edit Trash View Duplicate

Checkout

Contact

Purge cache

Author

Jerod Morris

Jerod Morris

Jerod Morris

Jerod Morris

Jerod Morris

Jerod Morris

Date

2014/01/24
Published

2014/09/11
Published

2014/04/09
Published

2014/01/24
Published

2014/01/22
Published

2014/01/24

Search Pages

13 items

ID

15
340
80

19

17
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Step 6: Add Dynamic Sidebar to About Page (Homepage)

Comments

No comments yet.

Scripts

Page-specific Scripts

Suitable for custom tracking, conversion or other page-specific script. Must include script
tags.

Select Page Protection:

¢ No Membership Required
Has Member Group access to

Does not have Member
Group access to

Choose the member group(s):

free

Set Drip Delay

Sidebar Selection

Secondary Navigation

Secondary Navigation

Secondary Menu

Featured Image

Set featured image

v Default
Blog
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Step 6: Add Dynamic Sidebar to About Page (Homepage)

C )y @ jerod-morris.preview111.rmkr.net/blog/ Q w9 o

4+ AddNew ¢ Edit / Manage © Help EditPage § Edit with Visual Editor o 8¢  Greetings, Jerod Morris

4

PRIMILITY HOME BLOG

What Are the Benefits of Keeping Pride Uncategorized
and Humility in Balance? Basics

MARCH 7, 2017 BY JEROD MORRIS (EDIT)

_

What Are the Benefits of Keeping

RECENT POSTS

Pride and Humility in Balance?
This is a test post.

Sample Post With Image Aligned
Right

Example Blog Post

SOCIAL ICONS

i s )y

You should do everything in your power to

stay on the straight and narrow between 'AINMAKER PLATFORM

pride and humility.
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Question 2 (Steve)

What is the best practice for including PDF documents in blog posts? |

have an Insurance agency and am thinking of posting insurance quotes

(once personal information is removed) to give visitors an idea of actual
prices customers are paying for insurance.
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Step 1: Go to the Download Manager
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Step 1: Go to the Download Manager

éé 4+ Add New & Edit /# Manage © Help

o .
Conversion

> I Dashboard

Setup Wizards

Products A/B Tests -
43 Coupons

Orders
Right Now in Forums v

_

Member Groups
Members

| Download Manager
A/B Tests

Formulas
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Step 2: Upload Your PDF
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Step 2: Upload Your PDF

Create New Download - vew |
Give your

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog _ dOwn IOad fi Ie

: a descriptive
name.

Link URI Save link to generate URI Member Groups “
File All Groups = Most Used

v| free
Upload new file Choose File | RMSBR_template_qa_3.pdf

+ Add New Member Group

Publicly Accessible v'| Allow the public to access this file.

Delay Access Days
Delay access to this file by X days after signup.

Track Downloads v'| Track all downloads of this file.

Include in Shortcode v'| Include in Member Downloads shortcode.

{AINMAKER PLATFORM



Step 2: Upload Your PDF

Create New Download - vew

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Link Details

Link URI

File

Upload new file

Publicly Accessible

Delay Access

Track Downloads

Include in Shortcode

Save link to generate URI

Choose File | RMSBR_template_qga_3.pdf

v'| Allow the public to access this file.

Days
Delay access to this file by X days after signup.

v'| Track all downloads of this file.

v'| Include in Member Downloads shortcode.

Status a

.

Choose the
Member
Group
required for
access (if
applicable)

Member Groups -

All Groups  Mogt Used

+ Add New Member Group

YAINMAKER PLATFORM



Step 2: Upload Your PDF

Create New Download - vew

Status a

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Link Details A Delete

Link URI Save link to generate URI Member Groups -

File All Groups  Most Used C h o O S e y O u r

v free

m file and

|
Publicly Accessible v'| Allow the public to access this file. u p I o ad I t m

Upload new file Choose File | RMSBR_template_ga_3.pdf

Delay Access Days
Delay access to this file by X days after signup.

Track Downloads v'| Track all downloads of this file.

Include in Shortcode v'| Include in Member Downloads shortcode.

{AINMAKER PLATFORM



Step 2: Upload Your PDF

Create New Download - vew

Status a

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Link Details A Delete

Link URI Save link to generate URI Member Groups =

File All Groups Most Used Adj u St the

v free

Upload new file Choose File | RMSBR_template_ga_3.pdf Ot h e r

+ Add New Member Group

|
publicly Accessible 7] Allowthe public to acces thi il setil ngs as

| heeded.

Delay Access Days
Delay access to this file by X days after signup.

Track Downloads v'| Track all downloads of this file.

Include in Shortcode v'| Include in Member Downloads shortcode.
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Step 2: Upload Your PDF

Create New Download - vew

Status a

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Link Details ° h Save .

Link URI Save link to generate URI Member Groups “
File All Groups = Most Used

v free
Upload new file Choose File | RMSBR_template_qa_3.pdf

+ Add New Member Group

Publicly Accessible v'| Allow the public to access this file.

Delay Access Days
Delay access to this file by X days after signup.

Track Downloads v'| Track all downloads of this file.

Include in Shortcode v'| Include in Member Downloads shortcode.
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Step 2: Upload Your PDF

—dit Download

n Link published.

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Link Details -

http://jerod-morris.preview111.rmkr.net/?
download_id=23f08ba4b12e482f8b8e77fabb2eabbb

Link URI

File RMSBR_template_qga_3.pdf

Upload new file Choose File  No file chosen

Publicly Accessible v'| Allow the public to access this file.

Delay Access Days

Delay access to this file by X days after signup.

Track Downloads v| Track all downloads of this file.

Include in Shortcode v| Include in Member Downloads shortcode.

Status A

..

- You’ll know the
upload was
successful

when you see

the file name In

this previously
bank field.

Member Groups

All Groups

+ Add New Member Group
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Step 2: Upload Your PDF

—dit Download

n Link published.

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Link Details

Link URI

File

Upload new file

Publicly Accessible

Delay Access

Track Downloads

Include in Shortcode

Status A

You can copy
_ this URL to
weess wvea  CHE@Ate @ link on
any page on
your site.

http://jerod-morris.preview111.rmkr.net/?
download_id=23f08ba4b12e482f8b8e77fabb2eabbb

RMSBR_template_qa_3.pdf

Choose File  No file chosen + Add New Member Group

v'| Allow the public to access this file.

Days
Delay access to this file by X days after signup.

v'| Track all downloads of this file.

v'| Include in Member Downloads shortcode.
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Step 3: Insert Into Any Page on Your Site
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Step 3: Insert Into Any Page on Your Site
Add New Post v

. . Publish -
Test Page for Downloading PDF of Slides
Permalink: - Edit View Post Save Draft
O Preview
8 Add Media _
Visual Text Save draft or publish to enable the visual
editor.
B I = = = ¢« — = = = 2 R ZE T NBhB € o
| Insert Download ? Status: Draft Edit h I
@ Visibility: Public Edit
) pubishimmeditly i Download from
| |
o sco editor options.
Move to Trash
Word count: 0 Draft saved at 2:55:41 pm. Categories -
Layout Settings . All Categories =~ Most Used

Select / Deselect All

Setack Layous *  Default Layout set in Design Settings Basics
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Step 3: Insert Into Any Page on Your Site

X

Start typing the
name of your
file and it will
come up. (See
hy | suggested
a descriptive

name?)

Insert Download

Select Download:
Slides|

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog
LMK rexcupuorndry).

Insert Download
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Step 3: Insert Into Any Page on Your Site

Insert Download

Select Download:
Slides: Q&amp;A on Setting Up and Managing Your Rainmaker Blog

Link Text (Optional):
Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

Insert Download

Add link text,
then click Insert
Download.
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Step 3: Insert Into Any Page on Your Site

Admin Screen Opt

Add New PoOst ~ v

Test Page for Downloading PDF of Slides Publish -

Save Draft

= e Now you have a
Visual Tfex‘t ﬁZ,V; jmﬂ or publish to enable the visual cl i c k a b I e I i N k to
your PDF.

Permalink: . view11 Edit View Post

27 Add Media

B I # = £ ¢ — = = = & R =

Slides: Q&A on Setting Up and Managing Your Rainmaker Blog

@ Visibility: Public Edit

i1 Publish immediately Edit

® SEO: N/A

Move to Trash

Categories -

Word count: 0 Draft saved at 3:00:06 pm.

Layout Settings . All Categories =~ Most Used

Select / Deselect All

e Default L avout set in Design Settines Basics ,/’/ R A I N M A K E R P I_ AT FO R M

Select Layout



Step 3: Insert Into Any Page on Your Site

—dit Post ’ Ve

n Post draft updated. Preview post

Wh ICh can Test Page for Downloading PDF of Slides R ‘
eaSIIy be tu rned Permalink: http://jerod-morris.preview111.rmkr.net/test-page-down...ing-pdf-slides/ ' Edit = View Post Save Draft

into a clickable o b

Add Media =
Visual Text & Edit with Visual Editor
b u tto n | b J/ link bquote del ins img ul ol |i code more closetags CopyHTML

LY
-

¥ Status: Draft Edit
lass="button" href="http://jerod-morris.previewlll.rmkr.net/?
download _id=23f08badbl2e482f8b8e77fab62eabbb” xlink="href">Slides: Q&amp;A on Setting Up and Managing Your @ Visibility: Public Edit

Rainmaker Blog</a>

i1l Publish immediately Edit

® SEO: N/A

Move to Trash

Categories -

4

Word count: 10 Last edited by Jerod Morris on March 15, 2017 at 3:01 PM

All Categories =~ Most Used
Layout Settings A gori ost Use

______ \MAKER PLATFORM



Now your
audience can
get the PDF
with one click of
the button.

Step 3: Insert Into Any Page on Your Site

PRIMILITY

Test Page for Downloading PDF of Slides

MARCH 15, 2017 BY JEROD MORRIS (EDIT)

¢ O] ¥ Tveet | in N
Here is some text introducing the PDF.

Hey! You should download this PDF! It's the
bee’s knees!

SLIDES: Q&A ON SETTING UP AND MANAGING YOUR

RAINMAKER BLOG

Thank you. Hopefully you enjoy the
information.

Now please share this page with your

friends. <
¢ I ¥ rveet | in IO

ria nroviow111 rmlbr nat 2dnuwnlnan id=2ANRAKaAdh120AR2f ANRAaT 7iahR20aRAN

EMAIL NEWSLETTER

This is an example of an opt-in
form widget that can be used in
your sidebar or other Content

Areas
Your Name
E-Mail Address

RECENT POSTS

What Are the Benefits of Keeping
Pride and Humility in Balance?

This is a test post.

Sample Post With Image Aligned
Right

Example Blog Post

SOCIAL ICONS

BEBR00

IMAKER PLATFORM



Step 3: Insert Into Any Page on Your Site

+ AddNew @ Edit / Manage © Help  ViewlLMS ' Greetings, Jerod M

> Lightbox Height pixels
Membership Group -

Leave empty to allow automatic height.

)
Note: If you’re N
Select Page Protection:
- Media Placement After C No Membership Required
c re at I n g a n L M S errenen - Has Member G'roup :clcess to

Select where the embed media and download items will appear. To manually place the
, , _ L Does not have Member
embed media, add the [display Ims_media] short code where you would like it to appear

| |
item, find the
) Choose the member group(s):
“Add D
OW n O a i free
Show in how many days?
, , , Set Drip Delay
= 5y When access to the page is restricted to a Membership Group, enter the number of days
L I n k b u tt O n to to delay the media display, or leave blank to display the media immediately.
|
I n Se rt yo u r Drip Message
Use this box to customize the message that readers will see when they do not yet have
OW n O a - access to delayed content.

Add Download Link Default

Sidebar Selection 4
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Question 3 (Mike)

What t
ype of disclal
alm
er does Chris use for hi
IS affiliate [
Nks?

7,
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Question 3 (Mike)

What type of disclaimer does Chris use for his affiliate links?

NB. As always also, even though they won't cost you a penny more, and nothing

influences my suggestions and opinions, | do use dffiliate links, so if you buy

after clicking | might get a couple of dollars in return.

7/ RAINMAKER PLATFORM
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Question 4 (Lori)

(I'm planning to submit my business plan for an ABC hot seat session, but would like to get
further along before | do. I'm wanting three demo sites when I'm all said and done: one using

StudioPress themes @ Synthesis, one using New

StudioPress Sites, and one using Rainmaker.)

My Rainmaker site is going to be a hyperlocal podcast network (among other things). | would

like to Incubate hyperlocal podcasts that can
concern the ability to host these podcasts as re
Can | use both a site URL and a podcast specific

be spun into their own sites. My questions
ated but separate content using categories.
redirect? (I'm pretty sure the answer is yes to

this one, but my other questions flow from this premise.)

Do | attach the redirected URL to the archive page for the podcast category? Will the redirect
apply to both the parent category archive page and any "children” associated with it?

When we set the social media sharing options, are they only set for the parent site or can we
set them differently for each parent category? Do | need both a blog and a podcast feed or
can they be combined? (Pretty sure it's the latter, but double checking)

7/ RAINMAKER PLATFORM



Step 1: Create a Podcast Series
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Step 1: Create a Podcast Series

+ Add New 2 Edit & Ma

Content

Posts

Pages

Landing Pages
Portfolio

Podcast Episodes
Media

Redirect Links
Forums

LMS

Book Library

Post Categories
Post Tags

Podcast Network
Podcast Keywords
Portfolio Type
Editorial Calendar
Book Authors
Book Series

Book Tags

Forms
Quizzes
RSS Feeds

Import
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Step 1. Create a Podcast Series

¢¢ + AddNew 2 Edit /~ Ma
> Admin Screen Opt

Content Podcast Network

?*

Search Network

o E Posts
Pages Add New Podcast Series _ -
. Bulk Actions Apply
Landing Pages
Name
Portfolio
Podcast Episodes | Name Slug Series feed URL Episodes ID
Media Name is how it will appear on your website.
Redirect Links Assembly Call classic http://assemblycall. 15 341
Forums Slug Classic com/series/classic/f
eed/
LMS
Book Library Slug is the URL-friendly version of the name. It should be all
lower case, and contain only letters, numbers, and hyphens.
Ball Isn't Life - ball-isnt-life http://assemblycall. 3 425
Get to Know the com/series/ball-
None Podcast at a
Post Tags .
Time
| Podcast Network
Add New Podcast Series
Podcast Keywords
Portfolio Type
N Bracketology.fm bracketolo http://assemblycall. 19 337
Editorial Calendar , &Y &y P _ Y
with Andy com/series/bracket
Book Authors Bottoms ology/feed/
Book Series
Book Tags
|
Hoosier Talk hoosier-talk http://assemblycall. 1 339
com/series/hoosier-
Forms talk/feed/
Quizzes
RSS Feeds Postgame postgame-shows-2014- http://assemblycall. 38 223 % M
Shows 2014-15 15 com/series/postga

Import



Step 1. Create a Podcast Series

Edit Podcast Series

Name

AU Jureg wpuuin

Bracketology.fm with Andy Bottoms

Name is how it will appear on your website.

Parent

Sidebar Options

Primary Sidebar

Secondary Navigation

Secondary Navigation

Podcast Settings

Series Feed URI

Slug is the URL-friendly version of the name. It should be all lower case, and contain only letters, numbers, and hyphens.

None

Bracketology.FM

Genesis Default

http://assemblycall.com/series/bracketology/feed/

INMAKER PLATFORM



Step 1. Create a Podcast Series

Edit Podcast Series

Name

Slug

Parent

Sidebar Options

Primary Sidebar

Secondary Navigation

Secondary Navigation

Podcast Settings

Series Feed URI

AU Jureg wpuuin

Bracketology.fm with Andy Bottoms

Name is how it will appear on your website.

bracketology

Slug is the URL-friendly version of the name. It should be all lower case, and contain only letters, numbers, and hyphens.

None

Bracketology.FM

The category
page will be this
URL minus the
“/feed/” part.

http://assemblycall.com/series/bracketology/feed/ _

Genesis Default

INMAKER PLATFORM



Step 1. Create a Podcast Series

AU Jureg wpuuin

Edit Podcast Series

Name

Slug

Parent

Sidebar Options

Primary Sidebar

Secondary Navigation

Secondary Navigation

Podcast Settings

Series Feed URI

Bracketology.fm with Andy Bottoms

Name is how it will appear on your website.

bracketology

Slug is the URL-friendly version of the name. It should be all lower case, and contain only letters, numbers, and hyphens.

None

Bracketology.FM _ I also created a

dynamic
sidebar for this
Genesis Default pOdcaSt serieS-

http://assemblycall.com/series/bracketology/feed/ ‘ I N M A K E R P I_ AT FO R M



Step 1. Create a Podcast Series

Podcast Series Archive Settings

Archive
Headline

Archive
Intro
Text

Bracketology.fm with Andy Bottoms

Leave empty if you do not want to display a headline.

<p><strong>Andy Bottoms is the #1-ranked bracketologist in the world, <a href="http://www.bracketmatrix.com/rankings.html"
target="_blank">according to Bracket Matrix</a>.</strong> In his weekly podcast, he interviews a variety of guests and provides college basketball
analysis with a bracketologist's bent. </p>

<a class="spreaker-player" href="https://www.spreaker.com/show/2020916" data-resource="show_id=2020916" data-width="100%" data- .
height="350px" data-theme="light" data-playlist="show" data-playlist-continuous="true" data-autoplay="false" data-live-autoplay="false" >Listen to I t t h h
"Bracketology.FM with Andy Bottoms" on Spreaker.</a> Se u p e a rc |Ve

|
<center><a class="button button-secondary" target="_blank" href="http://assemblycall.com/bracketology/">View Andy's latest bracket</a></center> p ag e to I n c I u d e a n
<table> ;

- external player that

<tr>
<td><center><a href="https://www.facebook.com/bracketologyfm" target="_blank"><img src="http://assemblycall.com/wp-

content/uploads/2016/08/fb-logo.png" alt="Facebook" /></a></td></center> i n c I u d es eve ry

<td><center><a href="https://twitter.com/andybottoms" target="_blank"><img src="http://assemblycall.com/wp-content/uploads/2016/08/twitter.png"
alt="Twitter" /></a></td></center>

u
<td><center><a href="https://itunes.apple.com/us/podcast/bracketology.fm-andy-bottoms/id1174169947" target="_blank"><img e p I S O d e 5 as We I I as

src="http://assemblycall.com/wp-content/uploads/2016/08/contentitunes.png" alt="iTunes" /></a></td></center>

<td><center><a href="https://play.google.com/music/listen#/ps/Ixlwhsabyzbbyd2kdmezlswrynm" target="_blank"><img - f - - I I - k
src="http://assemblycall.com/wp-content/uploads/2016/08/contentgoogle-play-music.png" alt="google play music" /></a></center></td> S pec I I c S 0 c I a I n S O
<td><center><a href="http://tunein.com/radio/Bracketologyfm-with-Andy-Bottoms-p930621/" target="_blank"><img src="http://assemblycall.com/wp- i
content/uploads/2016/08/tunein-radio.png" alt="tune in radio" /></a></td> N t m R k
<td><center><a href="http://www.stitcher.com/podcast/jerod-morris/bracketologyfm-with-andy-bottoms?refid=stpr" target="_blank"><img ( O e m al n m a e r

src="http://assemblycall.com/wp-content/uploads/2016/11/stitcher-logo.png" alt="stitcher" /></a></td></center>

oo social settings are

</table>

site-wide.)

Leave empty if you do not want to display any intro text.
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Step 1. Create a Podcast Series

Podcast Series Archive Settings

Archive
Headline

Archive
Intro
Text

Bracketology.fm with Andy Bottoms

Leave empty if you do not want to display a headline.

<p><strong>Andy Bottoms is the #1-ranked bracketologist in the world, <a href="http://www.bracketmatrix.com/rankings.html"
target="_blank">according to Bracket Matrix</a>.</strong> In his weekly podcast, he interviews a variety of guests and provides college basketball
analysis with a bracketologist's bent. </p>

<a class="spreaker-player" href="https://www.spreaker.com/show/2020916" data-resource="show_id=2020916" data-width="100%" data- .
height="350px" data-theme="light" data-playlist="show" data-playlist-continuous="true" data-autoplay="false" data-live-autoplay="false" >Listen to I t t h h
"Bracketology.FM with Andy Bottoms" on Spreaker.</a> Se u p e a rc |Ve

|
<center><a class="button button-secondary" target="_blank" href="http://assemblycall.com/bracketology/">View Andy's latest bracket</a></center> p ag e to I n c I u d e a n
<table> ;

- external player that

<tr>
<td><center><a href="https://www.facebook.com/bracketologyfm" target="_blank"><img src="http://assemblycall.com/wp-

content/uploads/2016/08/fb-logo.png" alt="Facebook" /></a></td></center> i n c I u d es eve ry

<td><center><a href="https://twitter.com/andybottoms" target="_blank"><img src="http://assemblycall.com/wp-content/uploads/2016/08/twitter.png"
alt="Twitter" /></a></td></center>

u
<td><center><a href="https://itunes.apple.com/us/podcast/bracketology.fm-andy-bottoms/id1174169947" target="_blank"><img e p I S O d e 5 as We I I as

src="http://assemblycall.com/wp-content/uploads/2016/08/contentitunes.png" alt="iTunes" /></a></td></center>

<td><center><a href="https://play.google.com/music/listen#/ps/Ixlwhsabyzbbyd2kdmezlswrynm" target="_blank"><img - f - - I I - k
src="http://assemblycall.com/wp-content/uploads/2016/08/contentgoogle-play-music.png" alt="google play music" /></a></center></td> S pec I I c S 0 c I a I n S O
<td><center><a href="http://tunein.com/radio/Bracketologyfm-with-Andy-Bottoms-p930621/" target="_blank"><img src="http://assemblycall.com/wp- i
content/uploads/2016/08/tunein-radio.png" alt="tune in radio" /></a></td> N t m R k
<td><center><a href="http://www.stitcher.com/podcast/jerod-morris/bracketologyfm-with-andy-bottoms?refid=stpr" target="_blank"><img ( O e m al n m a e r

src="http://assemblycall.com/wp-content/uploads/2016/11/stitcher-logo.png" alt="stitcher" /></a></td></center>

oo social settings are

</table>

site-wide.)

Leave empty if you do not want to display any intro text.
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+ AddNew 2 Edit  Manage © Help  Edit PodcastSeries  Clear Cache o3

The

ABOUT CONTENT FORUMS MEMBERS SUPPORT SUBSCRIBE LIVt

Bracketology.fm with Andy
Bottoms

Andy Bottoms is the #1-ranked bracketologist in the world,

according to Bracket Matrix. In his weekly podcast, he interviews a

variety of guests and provides college basketball analysis with a

bracketologist's bent.

019: Chris Dobbertean, Dave  Spreaker® JElR{eL A=y elNo e} 820
Ommen, and Ed Feng

4 ® < with Andy
00:00 01:14:50 Bottoms

19 episodes 19 hours, 18 minutes
019: Chris Dobbertean, Dave Ommen, and Ed Feng 01:14:50
018: Jordan Majewski and Raphielle Johnson 01:21:00
017: Matt Norlander of CBS Sports 39:29

Step 1. Create a Podcast Series

Go to bracketology.fm to

view the full page.

VIEW ANDY'S LATEST BRACKET

ANDY BOTTOMS |/ MARCH 13, 2017 (EDIT)

racketology.FM
:pisode 19: Chris
Yobbertean, il

Bottoms

BRACKETOLOGY.FM

ill.com/shows/bracketology-fm-episode-19-chris-dobbertean-dave-ommen-ed-feng/


http://bracketology.fm

Step 2: Create a URL Redirect

Go to bracketology.fm to
view the full page.
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http://bracketology.fm

Step 2: Create a URL Redirect

1. Buy your domain (bracketology.fm) and DNS —

this is not done at Rainmaker.

77 RAINMAKER PLATFORM


http://bracketology.fm

Step 2: Create a URL Redirect

1. Buy your domain (bracketology.fm) and DNS —

this is not done at Rainmaker.
2. Via your DNS settings, you can set up a Domain
Forward. Do this and forward your new domain

to the series page (assemblycall.com/series/

bracketology

77 RAINMAKER PLATFORM


http://bracketology.fm
http://assemblycall.com/series/bracketology

\\\

Question 5 (Susanna)

| have digital and physical products | would like to offer, but | do not
know the best way to set up an online store/storefront. | know there
are limitations to the RM platform when it comes to this, but | would
love to be able to keep everything connected on my site. Would you
suggest setting up a store and storefront with RM? And if so, how can |
set up a professional-looking store front? Or would you use a third
party like Shopify?

Thank you so much for doing these webinars, they are extremely
helpful and encouraging!

7/ RAINMAKER PLATFORM
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Question 5 (Susanna)

| have digital and physical products | would like to offer, but | do not
know the best way to set up an online store/storefront. | know there
are limitations to the RM platform when it comes to this, but | would
love to be able to keep everything connected on my site. Would you
suggest setting up a store and storefront with RM? And if so, how can |
set up a professional-looking store front? Or would you use a third
party like Shopify?

Thank you so much for doing these webinars, they are extremely
helpful and encouraging!

Ask Support to refer you to Services.

7/ RAINMAKER PLATFORM



N\

Question 6 (Peter)

You spoke about important "pages to have: About; Subscribe;
Resources,; Services. Taking Maker Hacks as an example, it does not
appear to me to have "Subscribe” as a top (or any) menu option
(whereas the others do appear there). Is it just an "invisible” or
unattached page, linked to from, say, blog posts, guest posts, interview

‘where can we find you online?" questions? Do you consciously decide

not to put the Subscribe page on a menu or is it just a "lack of space’
thing? What's the thought process? Thank you.

7/ RAINMAKER PLATFORM
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Question /7 (Roger)

I'm currently working on my Rainmaker site using the Minimum Pro theme, and will eventually
migrate my existing site over. | have a couple of questions regarding navigation for my content:

1) On my existing site, which has a typical blog-type homepage, | have navigation below the
header that relates to my categories. / navigation tabs show, and within those are 10 more as
drop-downs. | do intend to reduce/consolidate the number of categories (I know Chris
recommended having 5-7). My question is: | see quite a few blogs today that don't have
navigation like this. | presume they rely on people using the Categories and Tags listed at the
end of each post. If so, should | then adopt this style? (And then, if | don't have navigation tabs
for categories, does a Search box then become the main way people find topical articles? I'm

not a fan of tag clouds.)

2) One of the navigation links I'd li

cornerstone content, o

"which there w

Could that be the "Reso

urces” tab? And

ke to have at the top (header area) would be for my

Ill be 4 main topics — each having its own landing page.
would that tab then have a drop-down for the 4 topics?

7/ RAINMAKER PLATFORM



Edit Menus
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Edit Menus

Design

Themes

Appearance
| Menus —
Content Area

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode

77 RAINMAKER PLATFORM



Edit Menus

Menus

Edit Menus Manage Locations

Select a menu to edit: Primary Menu (Header Menu) Select or create a new menu.

Pages v

Posts v

Custom Links Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.

/site.com/resources

Home CustomLink
Resources
Blog Page v
Add to Menu
Library Page v
Categories -
Contact Page v

Menu Settings

Automatically add new top-level pages to this menu

v Header Menu
After Header Menu

Footer Menu (Currently set to: Widget Menu)

77 RAINMAKER PLATFORM



Menus

Edit Menus

Select a menu to edit:

Pages
Posts

Custom Links

Edit Menus

+ Manage in Appearance

Manage Locations

Primary Menu (Header Menu) Select Or create a new menu.

v Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.
ategories

Most Used View All

v| Uncategorized
v Basics

Select All

Home CustomlLink
Search
Blog Page v
Library Page v
Add to Menu
Contact Page v
Resources CustomlLink

Menu Settings

[ WA IS N | RN PN RS [ e R R 1 T RS
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Edit Menus

Menus

Edit Menus Manage Locations
Select a menu to edit: Primary Menu (Header Menu) Select or create a new menu.
Pages v :
Primary Menu
Posts v
Custom Links v Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.
ategories

Home
Most Used  View All Search
Uncategorized Blog
Basics
Library
Select All Add to Menu
Contact
Resources

Uncategorized

Basics

Menu Settines

Custom Link

Page

Page

Page

Custom Link

Category

Category

Notice how they
are all aligned

vertically?
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Menus

Edit Menus

Select a menu to edit:

Pages
Posts

Custom Links

Most Used View All

Uncategorized
Basics

Select All

Edit Menus

+ Manage in Appearance

Manage Locations

Primary Menu (Header Menu) Select

Search

Add to Menu

v

v

v

or create a new menu.

Primary Menu

Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.

Home

Blog

Library

Contact

Resources

Uncategorized sub item

Basics

Menu Settings

e Click and drag the

~ " items you want to be
— in the submenu

- beneath the intended

‘ Earent item.

77 RAINMAKER PLATFORM



Edit Menus

Menus

Edit Menus Manage Locations
Select a menu to edit: Primary Menu (Header Menu) Select or create a new menu.
B ' i | Save Menu
Primary Menu
Posts v
Custom Links = Menu Structure

Most Used View All Search

Uncategorized
Basics

Select All Add to Menu

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.

Home CustomlLink =
Blog Page v
Library Page v
Contact Page v
Resources Custom Link
Uncategorized sub item Category v
Basics sub item Category v

77 RAINMAKER PLATFORM



Edit Menus

4+ AddNew ¢ Edit , Manage @ Help EditPage  § Edit with Visual Editor £ 8¢ Greetings, Jerod Morris

4

PRIMILITY LOG CONTAC RESOURCES

uncategorizead

Primary Sidebar
Content Area

Welcome to our website! This s the Primary Sidebar
Content Area. You can add

Want our best content delivered directly to content to this area by Visi“”i
your an

your inbox? Subscribe via email: adding new widgets to this area.

When a user scrolls
over the parent item, the
submenu flys under.

SUBMIT

Email

A smart About Page is an important part of
keeping the attention of your audience. It's

77 RAINMAKER PLATFORM
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Question 8 (Dan)

At some point, will you explain some of the more advanced blog post
features? Content optimizer, link building, and SEO settings?

7/ RAINMAKER PLATFORM
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Question 8 (Dan)

At some point, will you explain some of the more advanced blog post
features? Content optimizer, link building, and SEO settings?

Yes. We have an SEO webinar and Q&A planned for April.

7/ RAINMAKER PLATFORM



\\\

Question 9 (Duane)

As | begin to develop a content strategy | am not quite clear on the
difference between Category Pages and Cornerstone Content Pages.

Are they the same? Could you show us a comparison or example of the
two and how they work together or overlap?

7/ RAINMAKER PLATFORM
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Category Pages v Cornerstone Content Pages
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Category Pages v Cornerstone Content Pages

— C {y @ www.copyblogger.com/landing-pages/ w N B < C 1 ® www.copyblogger.com/landing-pages/ w8 w el v I

Copyblogger Words That Work copyb[ggger Words That Work

Our landing page guide will
Landing Pages make you smarter

TURN TRAFFIC INTO MONEY

This free guide will help you start creating killer landing
pages right away. Grab our free ebook, Landing Pages: How

to Turn Traffic into Money, when you register for

My.Copyblogger.com below.

What is a landing page?

The page you’re currently reading is a content landing page

IT'S FREE

designed to organize many related pages around an overall

theme.



%

Category Pages v Cornerstone Content Pages

&« C 1)} ® www.copyblogger.com/category/adaptive-content/ w8 8@ 0 :

é/ + Add New 2 Edit /& Manage ©® Help Edit Category Clear Cache

COPYblogger Words That Work Menu

Written by STEFANIE FLAXMAN | August 8,2016 | 23 COMMENTS (EDIT) Get iInstant
. access 1o
The Friendly Way to Adapt Your proven
o o marketing
Content Like a Flexible Yoga training — for
Instructor free.

1433

BREATHE DEEP AND
tune in to your audience

CTHEEREEEE  RAINMAKER PLATFORM



Category Pages v Cornerstone Content Pages

& C )} ® assemblycall.com/news-roundups/ QA % | 8 w JCEl v I

+ Add New & Edit /& Manage @ Help Edit Category  Clear Cache

The &”
ABOUT CONTENT FORUMS MEMBERS SUPPORT SUBSCRIBE LIVE

6-Banner Saturdays
Weekly IU Basketball News Roundups

Shares Every Saturday morning, we round up the most pertinent, well-

written, and compelling U basketball-related links from around the
web for the perusal and edification of our members. In other words:
We do the hard work to keep you up to date on your Hoosiers, so all

you have to do is read. :-)

6-Banner Saturday roundups are posted on our blog and sent via email
to our members. To gain immediate access to our 6-Banner Saturday

roundups, start your free membership to The Assembly Call today.

JOSH MARGOLIS /| MARCH 4, 2017 (EDIT)

6-Ba Saturd
p6-Banner Saturday: AT\

5
@
X
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Question 10 (Kelly)

Why does a customer have to create a username and password to buy a
product? My site isn't live yet and I'm still on Wordpress.com, but |'ve
had friends say they didn't follow via email because they didn't want to
create a username and password just to receive my blog by email. Why
add another resistance’ factor?

Your visitors will need to create a username and password
to become a member of your site. You do not need to
require a username and password for someone to become a
subscriber. Subscriber opt-in can be my email only.

7/ RAINMAKER PLATFORM



Free membership option

DO O . : G

8 J Smart Advice for Creating ... » |
el ] g \t
€& () g digitalcommerce.com/register/

Digital Commerce

INSTITUTE

7\
{ \/ J
N/

7\
(v )
N/

7\
(v )
./

7N\
( v )
O/

7\
{ \/ J
N/

7N\
(v )
N/

ACADEMY PODCAST PLATFORM

The Digital Entrepreneur Newsletter,
our weekly curated email newsletter

Six free lessons from the paid course
"Build Your Online Training Business
the Smarter Way" by Brian Clark

Three free lessons from the paid
course "How to Create Automated
Marketing Funnels that Work”

Three Case Study Webinars on
building a digital business, plus one
“Cutting Edge” webinar on using
Periscope for content marketing

Weekly episodes of The Digital
Entrepreneur podcast

Exclusive offers on tools, training,
conferences, and workshops

***Advance notice*** when we
reopen the doors to Digital
Commerce Academy and Brian
Clark’'s course Build Your Online
Training Business the Smarter Way
(currently closed until 2017).

HELP

Bl ¢

Q Search wB 9 3 A

Get free, instant
access today:

First Name:

Email Address:

Password:

Re-enter Password:

GET ACCESS

(4

LOG IN

% RAINMAKER PLATFORM




Subscription option (on exit)

©e / Il Smart Advice for Creating ... x\+

:- (i) & digitalcommerce.com/register/ vE1 @& Q Search w B 4 A £ # -

(4

The Digital
Entrepreneur

Want just the newsletter?

Sign up today and receive our weekly curated email newsletter, The
Digital Entrepreneur, with resources to help you create, sell, and grow.

knter your Email
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Question 11 (Heinrich)

1. How best to go about choosing topics for a blog(s)?

2. How does one monetize a blog or other content on
the Rainmaker Platform?
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Question 11 (Heinrich)

1. How best to go about choosing topics for a blog(s)?

2. How does one monetize a blog or other content on
the Rainmaker Platform?

7 monetization options:

Sell digital products (ebook, course, content library, etc.)

. Sell a paid membership

. Sell one-on-one coaching

. Sell offline services

. Sell products as an affiliate

. Sell sponsorships on your content

. Accept donations % RAINMAKER PLATFORM
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Question 12 (Arthur)

As a multimedia artist, I'd like to use graphics @ videos In
my content marketing strategy (in addition to articles).
My goal Is to attract an audience and build an email list

of people who like my “visual content.”

What strategies can | use, and what Rainmaker features
are available for working with graphical & video content?
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Question 13 (John)

| never have had any blog published before. Please advise
what platform to use for my blog and how to set up.
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| never have had any blog published before. Please advise
what platform to use for my blog and how to set up.
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Question 13 (John)

| never have had any blog published before. Please advise
what platform to use for my blog and how to set up.

studiopress.com

Introducing StudioPress Sites

WordPress made easy without sacrificing power or flexibility.

It's perfect for bloggers, podcasters, and affiliate marketers, as

well as those selling physical products, digital downloads, and
membership programs.
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Upcoming Sessions

How to Use Rainmaker to Turn Blog
Traffic Into Subscribers

Thursday, March 23 at 2:00 p.m. ET

Q&A on Using Rainmaker to Turn
Blog Traffic Into Subscribers

Thursday, March 30th at 1:00 p.m. ET
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Additional Questions?
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